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Part 3 — Making Datapacks with images, lithology
columns, etc. (Note: self-made datapacks only work with

TSCPro)

For convenience, and for the needed images for Exercise #2, download “TSCreator
Datapack-making items.zip” from the Download page at our website, and un-
zip it to use the individual files and image-folder.

EXERCISE #1 — Making vour own datapack for microfossil zones and events

(1) Gulf of Mexico, Rupelian
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We will use the Foraminifera markers of Shell Offshore Inc. (Michael Styzen, published by
Gulf Coast Section of SEPM in 1996; although he released a revised version later). This is a scan
of just the Rupelian portion of that chart. We will make a datapack for (1) the SP “standard zones”
of Shell, and (2) Shell’s “OL” foraminifer markers, which are a combination of benthic and
planktonic taxa. Details on all types of columns are in the detailed main Manual (200-page PDF at
the download page of website).

(2) Set-up

TSCreator uses tab-delimited text files. This format was selected so that users can make
entries in EXCEL columns, then do a separate “save-as” export as tab-delimited text. Alternatively,
one can use Word, and save the file as text, but this can be more tricky to easily see the tab-
columns.

We will make 3 data columns: Shell SP zones (a block column), Shell Foram markers
(an event column with simple arrows), Shell Foram details (and event column with separate
FAD and LAD arrows).

The format for data is quite simple.

(a) A header that gives the column type (and optional settings for color, width, etc.)

(b) A set of items with their ages (and optional dashed boundaries, pop-up comments, etc.)

IMPORTANT: The column sets must be separated by at least one blank row.

(3) Block (zones)

We will enter the three SP zones with the age of their bases.

Prepare the following [NOTE: you can just copy-paste each set into Excel; BUT, if you do
this from a PDF, then REMOVE the line-returns that Acrobat adds to the text-insert into those
cells, otherwise it creates a mess. For example, if you copy-paste from a PDF the item “SEPM
chart by Mike Styzen (1996)”, then remove the PDF-returns after “chart”, “Mike” and “Styzen”.]

NOTE: The downloaded “TSCreator Datapack-making items.zip” contains a WORD file
“RupelianDatapack_DocVersion_forCutPaste.doc” that will avoid such copy-paste errors from a
PDF version.

format
- 1.3
version.
date’ 16/01/2012
SEPM chart
Shell SP ) ok 501255/255/0 by Mike
zones Styzen
(1996)
TOP 27 1
SP 21 30.3 NOTE: LAD of
G. ampli.
SP 20 32.0dashed  [VOTE: definition 5, 500/
uncertain
SP 19 /18 33.8
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The first two lines are needed to notify the program what Format is being used (1.3 allows use of
separate colors for each zone, if desired) and the Date of this file.

Then, a blank row.

The “Shell SP zones” are a block-type format. Let’s use a default width of 50; and give it
the bright-yellow color of Shell’s logo (RGB is 255/255/0). The seventh column (column G) can
have a pop-up comment for the column title.

Each zone is entered, then its Age (as given on this SEPM chart). Notice that the lower
boundary of SP21 and SP20 are dashed on the chart — but, to see how this option works, just put
“dashed” after the SP20 (which has no indicated foraminifer marker). The next column (E) is for
pop-up comments. For fun, let’s give zone SP 20 a light-green color (the RGB code in column F).

(4) Datums — only simple arrows

Next, let us enter the OL “markers” as EVENTS. The column type is “event” (small
letters), and the options for sets of markers are “LAD”, “FAD” and “EVENT”. We will call these
“EVENT” for now.

After a blank-row (IMPORTANT to have a blank row separating each new header!), then
enter:

Shell Foram SEPM chart by Mik
She | Foram event 60  [255/255/0 on Styzencmggsb)y e
EVENT

oL 10 29.3

oL 11 29.7

oL 12 30.2

G. ampli. 30.3

oL 13 305

OL 14 313

oL 15 317

oL 16 31.9

oL 21 32.15

oL 23 32.25

OL 25 333

The column-header above used a slightly wider width (60). Because the data-heavy event-type
columns have a default of “off” to avoid accidental overcrowding of screen displays, then we’ve
inserted an override of “on” in column F of the header.



(5) Datums — both LADs and Events

Similarly, let’s compile the details of these events. There are two types used by Shell — LADs of

markers, and a set of EVENTS of acme’s, co-occurrences, and transgression.

After a blank-row (IMPORTANT to have a blank row separating each new header!), then

enter:
Shell Foram SEPM chart
details event 2001255/255/0 on |by Mike
Styzen (1996)

LAD

Nodosaria blanpiedi| 29.3

. species concept

G. ampliapertura 30.3|dotted varies

Anomallng 30.5

cocosensis var.

Tx. mississippiensis

LA var. 31.9

Tx. warreni 32.15

Cibicides pipeni 32.25

Cibicides

mississippiensis 33.3

var.
EVENT

Acme Discorbis 18 | 29.7

Trans. W|t_h U. cf. 30.2

cocoaensis

Tx. sellgi and

Cibicides aff. 31.3

moreyi

A_cme A_nomallna 317

bilateralis

We have long taxa names, therefore a generous width of 200 units is used (column header line).

The LAD of G. ampliapertura is apparently vague, therefore its marker will be dotted, and a pop-
up comment is added to explain this. Note that any pop-up comments for either datums or blocks

must be in column E.

Now, SAVE this Excel sheet as EXCEL; and then Save-As “TEXT (tab-delimited)”
format. Use a name such as “Shell_Rupelian_Forams.txt”.
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Saving from EXCEL (or other application) — For convenience for fast loading/locating, save to
the desktop. Always save your Excel sheet AS EXCEL format first; and only then save as “Text

(Tab-delimited)” with a new name. [NOTE, when Excel saves as “Text (Tab-delimited)”,

Microsoft tries hard to convince you that you really didn’t want to do this. Keep answering “Okay’

and “Yes”, then after doing that save-as-text, and finally Closing the file, answer “Don’t Save”

’
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(ves, that is correct) to retain the .txt format.] [NOTE2: If you save as “Unicode 16 (UTF-16)”,
then all international characters, such as 1, i, e, O, etc. will be preserved and displayed in
TSCreator, however the size of the resulting .txt file is twice as large due to 16-bit usage.

(6) Insert into T'S_Creator
Let us re-set the T'S-Creator to clear the previous datapack.
Under “File”, click “Replace Data with Default Datapack”.
Now, let us load the new Shell one that you’ve made — Under File, click Add datapack.
For the chart, we have a dense set of data. Therefore, under Settings (Time Interval), use
Top of 29 Ma, Base of 34 Ma; and a Vertical scale of 4.
Click Generate.

Voila !! It should look like the diagram below:
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File Data Image Halp
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Chart Title
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Aga Parod Epoch Stage Primar M,P,Crat Zones| Zones F zones | markars Shall Foram datalla
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Hieseamia blirieal
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We hope this is what you get, because it should work the first time. If not, then you may see
an error message indicating a problem with a certain line. This is the same line as in the Excel file,
and you can open that Excel file again to see what format might be wrong. Don’t panic; just look at
the instructions again, or ask us!

Just in case, we’ve provided a working version as “ANSWER -- Shell_RupelianForams .txt”
in the downloaded “TSCreator Datapack-making items” folder.
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EXERCISE #2 — Adding IMAGES to events and popups

Calcareous Nannofossil marker events of Late Jurassic of North Sea — from Bown & Cooper
(2000; in Paul Bown' book "Calcareous Nannofossil Biostratigraphy", with images of the
nannofossils from their NannoTax website.

NOTE: You will need to download the zip’d file “TSCreator Datapack-making items” — see
Top Lines of this Part 3. It contains “LateJurassicNannos_Exercise2_template.xls” and a
folder with images, “LateJurassic_Nannotax_Images”. Unzip it (!!), to access the files directly.

(1) Preparing datapack with Age-calibrations

Open the Excel file “LateJurassicNannos_Exercise2_template xls”. It has 3 sheets —
(i) Master Chronostratigraphy, which is the GTS2012 timescale for Boreal stages and ammonite
zones, (ii) Nannos, which is a skeleton that you will finish, and (iii) Qutput, which is a mirror to
selected columns in the “Nannos” sheet.

The provided Excel template has 2 worksheets open. Use the “Window -> Arrange ->
vertical” in Excel to view these side-by-side.

[NOTE: Opening “Part 3” templates from Excel (Exercises 2 and 3) in Window’s Excel — In
some versions of Excel, oddly, to see the dual-window files, you must then Click “View” in the
upper Excel menu, then “Arrange All” (middle of that menu), then “Vertical”. Stretch the
window to be able to see more of the two sheets; and you may need to scroll UP to see the
uppermost entries.

For Exercise#2 in Part 3 (Adding Images) — It will be easier to MOVE the folder
“LateJurassic_Nannotax_Images” to your Desktop. This will allow you to save your Excel
output from “LateJurassicNannos_Exercise2_template xls” directly into that Image-heavy folder,
followed by open it from within TSCreator.

In the diagrams of Paul Bown’s book, the placement of selected Nannofossil FAD/LAD
datums of Tithonian/Kimmeridgian are “drawn” relative to Boreal ammonite zones. We will use
the GTS2012 ammonite scale to calculate the corresponding ages by inserting a simple Excel-
equation that uses the Master Chronostratigraphy table for the ages of those Boreal zones.

In your Excel table, each entry for the nannofossil datums [either its appearance (FAD) or
extinction (LAD)] has an entry with this relative placement from the base of a Boreal ammonite
zone according to Paul Bown. Your first task is to compute the corresponding numerical Age value
based on the ages for these ammonite zones.

The first one, LAD of Stephanolithion atmetos, has been “wired” so Excel computes it for
you (look at row 12):

Stephanciithion atmetos <amg
align="middla"
arc="Stephanoithion_atmetos_SEM jp
a'= (MANNOTAX mage) [Chek: <a
href ="hitp://nannotax . org/category /m

Stephanoéithion atmetos
<ETg algn="midde”

Stephanolithion atmetos xlr:;qo' tvon stmet X NJ18 147.897 os fov ervlewfat clithinles/gt | PO Up in fittond Zone.
oa_SEMjpg*> - ephanolithiaceas/stephanolithion/step

hanolithion-atme”~Stephanclithion
atmetos</a~]. CALIBRATION = S0%
up in fittond Zone.

The Datum Calibration column indicates that this event is 90% up in the fittoni ammonite
zone.
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In the Master Chronostratigraphy sheet, you see the following ages for the Base of V. fittoni
and its Top (which is the base of the next-higher P. albani zone):

S8 Frogalbanites albani 147.93
Virgatopaviovia
59 fittoni Lea=ag

Therefore, the age of the LAD of nannofossil Stephanolithion atmetos would be the
relationship:
Base-of-Fittoni (minus) 90% of the Duration-of-Fittoni-zone.

The Base-of-Fittoni is Excel cell C89; therefore, the Duration-of-Fittoni-zone is equal to its
(Base — Top), or Cell C59 — Cell CS8.

If you highlight the “147.97” computed age in the Nannos Excel sheet for this LAD, you
will see that the Excel-equation is using the cells in the Master Chronostratigraphy:

='Master Chronostrat''C59-0.9*('Master
Chronostrat'!C59-'"Master Chronostrat'!C58)

Or, ( 148.35 - 90% * (14835 - 147.93)
=147.97 (Ma)

How to enter the equation into Excel:
Highlight the cell for entering the computed age
Type =
Click on base-fittoni age cell (148.35) in Master chronostrat
Type -0.9%(then click on base-fittoni age cell (148.35) in Master chronostrat
Type = (minus)
Click on base-albani age cell (147.93) in Master chronostrat
And, finally close the equation with ), Then, hit return.

The advantage of using Excel-equations is that if the age-scale changes in the future, or the
calibrations are revised, then one merely inserts those future values, and the computed ages of
events are automatically updated. We use this inter-linking to master-chronostratigraphy for all
datapacks of TSCreator, even including isotope curves.

Using this Excel-equation method, compute the remaining ages for Nannofossil datums
according to their relationship to Boreal ammonite zones. These are all the cells that have a
pending “For Excel Equation”.

(2) Attaching images to on-screen and popup entries

The method of attaching an image to a “name” is an HTML statement “img” with the
pointer to the image.

If the image is in the same directory as the TSCreator datapack text file, then one merely
needs to give the image-name. In our example, we will put the finished Nannofossil output text into
the folder “LateJurassic_Nannotax_Images” that has the suite of images for our fossils.

Look at Column B. This is the method of “concatenating” (merging) the information from
the “fossil-name” and the source (src) of the “image-name”, plus the required HTML flags that
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specify that this will be an image-call, set the image-size to be a small (40-unit) thumbnail version,
and center it after the fossil-name.

Stephanolithion atmetos <img align="middle" width="40"
src="Stephanolithion_atmetos_SEM jpg">

NOTE on “Concatenate”

If you have not used the method of Concatenate in Excel, you will discover that it is a very
powerful and time-saving method for merging information. It can even be combined with logical
“if-then” statements and other features.

A quick explanation for this example. If you Highlight the entry “Stephanolithion atmetos <img
align="middle" width="40" src="Stephanolithion_atmetos_SEM jpg">", you will see that the equation is:

=CONCATENATE(A12," ",$1$4,J12,$J$4)

The Concatenate take the text in Cell A12 (Stephanolithion atmetos) with a “ * (blank space),
then the text in Cell $1$4 (<img align="middle" width="40" src="). The dollar signs in this $I$4 implies
that a fixed Cell 14 will be used whenever this equation is pasted elsewhere; whereas the non-dollar-
sign “A12” implies a relative-placement, such that when the equation is pasted in the next line (13),
then it will point to Cell A13 instead. The information in Cell $1$4 has “<” to flag TSCreator that
the next items are HTML syntax, then “img” indicator that the instructions are to place an image
with align="middle” for centering relative to the fossil name text (our Cell A12), with a thumbnail
size of width="40". The image-file src="" will be the next item.

The next items in the Concatenate are the relative Cell J12 (Stephanolithion_atmetos_SEM.jpg),
which is the name of the image-file (which must be within double-quotes, hence the *“ after src=;
followed by a double-quote and end-of-HTML flag: “> (which is stored in fixed Cell $J$4).

When one pastes this Concatenate in the next lower line; then it will automatically use the
fossil name in Cell A13, and the image-file in Cell J13; but still use the fixed HTML commands in
Cell $1$4 and $J$4, or: =CONCATENATE(A13," ",$1$4,J13,5J%4)

In this way, we don’t need to keep typing in the elaborate information on how to designate
image placement, the names of the image sets, etc.; but can put the elements into a nice organized
suite of cells and columns, and merge these as desired.

(113

In column G, a more complex Concatenate is done to combine the fossil-name, fossil-image
(similar to what we did above, but with no “width” to enable a full-size photo) and a construction
for making a URL (using “href” flag) to the appropriate web-subpage at the Nannotax website.

FILL DOWN the other entries in Column (copy-paste the first cell into the lower Blank
ones) the same type of Excel-concatenate for the fossil events, and similarly with the pop-up
concatenate for those cells in Column G.

This information is auto-mirrored to the “Output” sheet.

(3) Outputing the Nanno.txt file, and using it from within the image-folder

FIRST, save your Excel file!

Only then, do a Save-As for the “Output” sheet — saving as .txt format — with a name such
as “LateJurassicNanno_QOutput.txt”. Alternatively, one can copy-paste this information directly
into a text-editor from Excel, then save as .txt.

Close your files.

Move this LateJurassicNanno_Output.txt file into the directory
“LateJurassic_Nannotax_Images” that contains the fossil images.
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Re-set the TS-Creator to clear the previous datapack.

Under “File”, click “Replace Data with Default Datapack’ .

Now, let us load the new Nannofossil one that you’ve made — Under File, click Add
datapack, then locate and open the directory “LateJurassic_Nannotax_Images” and add the
LateJurassicNanno_Output txt file.

Select a time-interval of 144 to 157 Ma, and a Vertical scale of 2.

Turn ON “Mouse over” (for seeing popups)

Turn OFF the Marine macrofossils column, and the Reconstructions column.

Under Microfossils, turn OFF Planktonic and Benthic Forams, and open Calcareous
Nannofossils to turn ON Boreal Nannofossils.

Generate.

The pop-ups will have larger images, and the links to Nannotax should be active.
Congratulations!

TimeScale Creator 2012 chart

Calcareous
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EXERCISE #3 — Making a litho-stratigraphy (rock column) datapack

FIRST: Re-set the TS-Creator to clear the previous datapack.
Under “File”, click “Replace Data with Default Datapack” .
The Public version of TSCreator has a 3000-character limit to uploaded datapacks (unlike
the Pro), and your Nannofossil one was nearly 2500. Therefore, we need to allow the program to
load your new one.

The provided Excel template for Exercise 3 has 2 worksheets open. Use the “Window ->
Arrange -> vertical” in Excel to view these side-by-side.

(1) Center of Norwegian-Danish Basin of North Sea

In keeping with our “Late Jurassic oil-gas” theme from the Australia-North Sea datapack
and Boreal nannofossils, we will use the Norwegian-Danish part of the North Sea.

In the following diagram, the rise and fall of sea level is seen quite dramatically by the
“retreat” (rising sea level) and “advance” (falling sea level) of the sands from river deltas. The high
sea level during the Tau Formation also has organic-rich oil-gas source rocks shown by black dots
near its base.

We will compile a lithology column for just the center of this basin.

Our lithologies and the pattern-names are:

Flekkefjord Fm. = Dark grey shales with some limestone stringers. We will use “Continental
marl” pattern (limestone in clay)

Sauda Fm. = Silty claystone to siltstone. We will use Siltstone pattern

Tau Fm. = Dark grey organic-rich non-calcareous shales (Claystone)

Egersund Fm. = Dark grey shales and siltstones. We will use “Sandy claystone” pattern.

Sandnes Fm. = glauconitic sandstone. We will use “Sandstone” pattern.
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Lithology Column - center of Norwegian-Danish Basin

Valanginian
Berriasian | Ryazanian
Tithonian| Volgian

e eKkallond. .. )
g .‘ﬁSauda/BjrarghaFvnE % =

Kimmeridgian L
Oxfordian "z~ Egersund
Callovian L S Candnae s,
DathAanian
Our central-basin “q hole”
1T INANALNSTL I ¥V INAL - “TOP”

Valanginian
Berriasian Ryazanian
Tithonian| Volgian
Kimmeridgian
Oxfordian
Callovian

DathAanian

Norwegian-Danish Basin (Egersund, Tau, Sauda and Flekkefjord Formation)
together form a single group, the Boknfjord Group. {NPD Bull.3}

The Sandnes Formation belongs to the Vestland Group.
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(2) Set-up for TSCreator formation-age set. [NOTE: For the workshop, we have included a
partly-formatted, partly-filled-in Excel worksheet.]

Norwegian-Danish basin --
Central column
Lithology Base Calibration
Group pattern Formation Age Pop-up text Lithology &
(TSC) (Ma) Comments
Boknfjord .
Primary
Group
LITHOLOGY= . Top of 50% up in
To 137.04 | section. CALIBRATION= | Top of section oK
P 50% up in Valanginian P Valanginian
. - Dark shale
LITHOLOGY= Dark shale
gg?ltmental Flekkefjord with limestone stringers. | with limestone
CALIBRATION= stringers
LITHOLOGY= Silty ;
Siltstone Sauda claystone to siltstone. Sllty, claystone
CALIBRATION= to siltstone
LITHOLOGY= Dark grey | Dark grey
Claystone | Tau organic-rich shales. organic-rich
CALIBRATION= shales
LITHOLOGY= Dark grey
Sandy Egerrsund sandy shales. Dark grey
claystone CALIBRATION= sandy shales
Vestland ,
Primary
Group
LITHOLOGY= Glauconitic "
Glauconitic
Sandstone | Sandnes sandstone.
CALIBRATION= sandstone

Column “A” — Group:

As you saw for British and Australia, the TSCreator puts a “grouping” name next to the
names of a set of component formations. The program recognizes this name by a “Primary”
flag in the 2nd column.

Norwegian-Danish basin suite of Egersund, Tau,. Sauda and Flekkefjord formations together form a
single group, the Boknfjord Group. The underlyng sandstone of Sandnes formation is the
uppermost Vestland Group.

=> Therefore, our “Primary” label will be “Boknfjord Group” above “TOP” of Flekkefjord, then a
“Vestland Group” Primary label between Egersund and Sandes formations.

Column “B” - Lithology pattern

There are a total of 248 lithology patterns built into TSCreator. The downloadable manual
(200 page PDF) has a table of these (in approximately the middle of that document). For this
simple example, we have provided the desired names. [NOTE: These are just “names of patterns”,
and are not meant to be formal lithologic nomenclatures. One merely selects a pattern that you'd
like to use to represent the actual lithology schematically on the final simplified column.]

Column “C” — Formation
This is the name to be placed next to the lithology pattern in the final diagram.
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Column “D” — Age
In the diagram, the age of each formation is shown relative to geologic stages as used in the
North Sea. Therefore, to compute the age of the base of that formation (except for “top” of
diagram, we only use bases), then one uses the placement of that basal-boundary relative to a
master-age scale for those geologic stages. Below are those ages from Geologic TimeScale 2012:

Boreal (high-latitude) geologic stages used in North Sea region

TOP 133.88 From GTS2012 summary

Valanginian 140.20 From GTS2012 summary 153/211/106

Ryazanian 144.10 anaaSy?u’?if Chetaites sibericus / Praetollia 140/205/96

Volgian 152.06 Base of E. magnum 217/241/247

. . Same as base-Baylei (based on Skye

Kimmeridgian 157.25 GSSP proposed definition) 204/236/244
. Base of Q. mariae ammonite zone.

Oxfordian 163.47 GSSP is not yet decided. 191/231/241
. Base of B. bullatus ammonite zone.

Callovian 166.07 GSSP is not yet decided. 191/231/229

Therefore, because the “top” of the Flekkefjord is approximately mid-way (50% from base) in the
Valanginian, then its numerical age is the Base Valanginian (140.20 Ma) minus 50% of the
duration of the Valanginian /0.5 * (140.20 — 133.88) = 3.16 myr)], hence 137.04 Ma.

Column “E” — Pop-up text

When one clicks on the formation pattern, we want to see a pop-up with the details on the
lithology, plus the information on how the basal age was derived.

For this purpose, we have entered the separate information on these two items in columns
“F” and “G”, then merged that information by using Excel’s command of “Concatenate”.

For the “top” of the Flekkefjord, this “merge cells” equation is:

=CONCATENATE("LITHOLOGY= ",F7,". CALIBRATION= ",G7)
Such Excel “merge information” commands are very useful.

(3) Compute Ages of Bases of each Formation

Your first task — By using the diagram, Fill in the “age of base of formation” relative to the
geologic stages, THEN use the reference Boreal age scale to compute those numerical ages.

You can either use a calculator, or, preferably, as we did for the Nannofossil datums, include
the “geologic stage age table” as a separate sheet in the Excel workbook, and use Excel to compute
the ages for you based on percent-up within each geologic stage.

THEN, use the CONCATENATE command to prepare the pop-ups for each item.

When you complete this table, then SAVE your Excel sheet (with date, name, etc.)

(4) Mirror and save as text output

Our last step is to extract the pattern-formation-age-popup information from the table, and
add the header for a “facies” (rock type) column.

You can either copy-paste into a text-program (e.g., TextEdit in Mac) and add the header
(plus the needed Format/Date initial lines as you did for Zones above), or prepare a mirror sheet
within Excel and save as tab-delimited text:
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Norwegian-
Danish
basin -- facies 100 | 255/255/255
Central
column
Boknfjord Primar
Group y
= i = 0, .
Top 137.04 LITHOITQGY Top of section. CALIBRATION= 50% up in
Valanginian
. [you are _ . . .
NOR Marl | Flekkefjord computing] LITHOLOGY= Dark shale with limestone stringers. CALIBRATI!
. [you are C o . _
Siltstone Sauda computing] LITHOLOGY= Silty claystone to siltstone. CALIBRATION=
[you are _ — _
Claystone | Tau computing] LITHOLOGY= Dark grey organic-rich shales. CALIBRATION=
Sandy [you are _ -
claystone Egerrsund computing] LITHOLOGY= Dark grey sandy shales. CALIBRATION=
Vestland Primar
Group y
[you are _ . -
Sandstone | Sandnes computing] LITHOLOGY= Glauconitic sandstone. CALIBRATION=

Optional -- you can also add a mirror of our geologic stages, although TSCreator already has these
built-in (including colors):

Boreal | ok 100 | 148/206/212 | notitie
stages
TOP 133.88 From GTS2012 summary
Valanginian | 140.20 From GTS2012 summary 153/211/106
. Base of Chetaites sibericus /
Ryazanian 144.10 Praetollia maynci 140/205/96
Volgian 152.06 Base of E. magnum 217/241/247
. I Same as base-Baylei (based on
Kimmeridgian | 157.25 Skye GSSP proposed definition) 204/236/244
. Base of Q. mariae ammonite
Oxfordian 163.47 Zone. GSSP is not yet decided. 191/231/241
. Base of B. bullatus ammonite
Callovian | 166.07 e T6o5P i not yot docided. | 191/231/229

Select interval of 140 to 166 Ma.

Your results, when placed against international stages, will be approximately:
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Part 4 — TS-Creator On-Line
(TSC-Lite)

Now, let’s use a browser interface into two new TimeScale Creator user-interfaces:

Internet-system #1 — TSCreator “Lite”

(1) Open a browser -- https://engineering.purdue.edu/Stratigraphy/tscreator/tsclite/

This may also be found as a Tab “TSC-Lite” at the top of the regular TSCreator website.

Chart Configuration Options
Start Age (Ma): |2 | End Age (Ma): |15
Vertical Scale (em/Ma): 1 ] Output Format: | svc @
(] Enable Popups On Generated Chart
[ Enable Event Column Stage Background Colors
[ Generate Chart )
Load Defaults | Clear All Selected Switch to Classic View
Global British Isles New Zealand
] Information Popups
Divisions of Time Major Fossil Groups
Eon . 4 ﬁ‘
ol o;
e @ ] e =
L - =
. -
period (O =3
Ammenaids Conodonts Graptalites Trilobites and older
Sub-Period D
Epoeh O
Age/Stage O m’
GSSPs .
Mammals Mesozoic Reptiles Planktonic Faram zones Nannafossil zones
Magnetic Polarity Sea-Lovel
low  high

This TSCreator is initially intended for educational and general-audience usage.

(2) Nannofossils — with Images and Nannotax links

In the top menu, set ages to be 120 and 140; and Vertical Scale to be 2.

Turn on “Enable Popups on Generated Chart”

Turn on (turn Green) the red-dot on Nannofossil zones.

Generate; Click the 1:1 icon. Explore.

The result is similar to when one downloads the TSCreator datapack “Calcareous
Nannofossils with Images” to “add” into the main TSCreator program. An advantage to the
TSCreator server system is that many datasets can have active images for immediate delivery.

Click on any Nanno, and you’ll get a pop-up with larger images, plus a direct link to
Nannotax for this species.

This system will work nicely on iPad, and even on iPhone — one can enlarge images
with one’s fingers.
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(3) Dinosaur evolution — with Images and links
At the top of the image, click “Back to Chart Settings”
For the age settings, use 110 to 200, with a vertical scale of 0.5

Click “off” the Nannofossils, and Click “on” Mesozoic Reptiles — this is the evolution of
dinosaurs and their relatives. The full evolution of vertebrates is a very large datapack that
can be downloaded for the full TS-Creator.

Click “off” the Magnetic Polarity and turn “off” Reconstructions (bottom of set)
Generate; Click the 1:1 icon. Explore.

The left-most set (with grey background) is a schematic evolutionary diagram. The other
columns are ranges of selected dinosaurs and relatives of different groups.

Click on any range, and a pop-up appears with information (especially for the selected range
sets). Many of these are also linked to external sites for more information.

As always, this is a work-in-progress.

(4) Humanoids — with Images and links (if you wish to explore more)
At the top of the image, click “Back to Chart Settings”
For the age settings, use 0 to 5, with a vertical scale of 6
Click “off” the Mesozoic Reptiles, and Click “on” Humanoids — this is the ranges of our
ancestors, plus tool cultures.
Generate; Click the 1:1 icon. Explore.
The images (and links) are provided by the Smithsonian and American Museum of Natural
History.

Our goal is to eventually have images for ALL fossil groups. Your contributions and
assistance would be very welcome!

Additional items -- Selected display options; “out of memory”, etc.

Saving Display Parameters (Settings) — Once you’ve created a screen display that you like, then
under Settings, there are bottom-buttons that enable you to SAVE ... a “Settings file” that
contains the necessary instructions for TimeScale Creator to recreate that display, or to
LOAD ... an earlier one to re-generate that same graphic for an audience or for additional
revisions. If you are working on a major diagram, then we suggest using this feature to
periodically save intermediate graphics, just in case the operating system has problems.
This setting option is also useful to standardize diagrams (fonts, arrangements, etc.).

Details on the many other capabilities and display options are illustrated under “Features” in
the Help menu (main window).

Have fun exploring the data sets and graphic options, and we hope that you will find this
suite useful for reference and generating base-graphics for your research and teaching.
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NOTE: The free public TimeScale Creator does not allow you to save charts after a datapack has
been added. Only the PRO version allows saving charts after uploading other datasets. See our
PRO page for other features, and how to get the PRO version (which comes with a large selection
of datapacks).

A word of advice during exploring — there are numerous close-spaced Foram and Nanno
events in the Neogene in the current database (and an abundance of Sequences in the glacial-pulsed
Pleistocene), so the auto-adjust software sometimes has problems to display these details unless a
vertical scale of at least 4 cm per 1 million years. A similar high-density of detail occurs with the
brief North American ammonite zones in the Campanian-Turonian interval and ammonite subzones
within much of the Jurassic-Cretaceous. Therefore, we have placed some of this dense-detail into
“additional” columns with the lesser-used secondary events, plus shorten the genera names for the
ammonites and other taxa.

A MEMORY problem that may occur -- The default Java installation on some operating
systems limits the amount of memory a program can use. This Java default may cause the program
to occasionally display out of memory (especially with large or information-heavy displays after
several iterations). DON’T PANIC! If this happens, a message will appear on the screen -- you
can still save the Sertings file to regenerate the on-screen display, and usually can save the non-
displayed SVG graphic file to be opened in another graphics program or Firefox-type browser. If
"Out of Memory" appears, then the TimeScale Creator Pro will also explain how to increase the
Java memory allocation. In many cases, hitting “GENERATE” again will solve the problem! If
that doesn’t work, then before you restart T7SCreator to clear Windows-memory, save your current
settings (See above for SAVE/LOAD) to not loose much time.

In addition, on Window machines, the screen refresh will become slower and slower —
again, the same JAVA problem in not clearing memory — so, save settings, then close and re-start
JAVA and TS-Creator again.

We welcome your suggestions for major and minor improvements in the default database,
visualization graphics, and overall system! Please convey your ideas, desires and critical
evaluations to us at jogg@purdue.edu.
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Database coordinator — James Ogg
[professor, Dept. Earth & Atmos. Sci., Purdue University, Indiana, jogg@purdue.edu]
and Chair, Subcommission on Stratigraphic Information, International Commission on
Stratigraphy

Visualization software developed by students of Purdue University




